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 Software (Printer Driver) 
 Operating Instructions 

 For Digital Imaging Systems 

 Before using this software, please carefully read these instructions completely and keep these operating 
instructions in a safe place for future reference. 

 English 
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The following trademarks and registered trademarks are used throughout this manual:

Microsoft, MS-DOS, Windows, Windows Server, Windows Vista and Internet Explorer are either 
registered trademarks or trademarks of Microsoft Corporation in the USA and other countries.
Microsoft product screen shot(s) reprinted with permission from Microsoft Corporation.
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Mac, Mac OS, Macintosh, TrueType and Apple are trademarks of Apple Inc., registered in the 
U.S. and other countries.
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Novell, NetWare, IntranetWare, NDS are registered trademarks of Novell, Inc. in the USA and 
other countries.
PEERLESSPage™ is a trademark of the PEERLESS Systems Corporation; and,
PEERLESSPrint® and Memory Reduction Technology® are registered trademarks PEERLESS
Systems Corporation; and, COPYRIGHT ©  2005 PEERLESS Systems Corporation.
COPYRIGHT ©  2005 Adobe Systems Incorporated. All Rights Reserved; and 
Adobe® PostScript® 3™.
Universal Font Scaling Technology (UFST) and all typefaces have been licensed from Monotype
Imaging Inc.
Monotype® is a registered trademark of Monotype Imaging Inc. registered in the U.S. Patent and 
Trademark Offi ce and may be registered in other jurisdictions. 
ColorSet™ is a registered trademark of Monotype Imaging Inc. registered in the U.S. Patent and 
Trademark Offi ce and may be registered in other jurisdictions. ColorSet™ Profi le Tool Kit, Profi le 
Studio and Profi le Optimizer are trademarks of Monotype Imaging Inc. and may be registered in 
certain jurisdictions.
COPYRIGHT ©  2007 Monotype Imaging Inc. All Rights Reserved.
PCL is a trademark of Hewlett-Packard Company.
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either registered trademarks or trademarks of Adobe Systems Incorporated in the United States 
and/or other countries.
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In these Operating Instructions, some ™ and ® marks are omitted from the main text.
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Unauthorized copying and distribution is a violation of law.
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System Requirements
Personal Computer : IBM® PC/AT® and compatibles (CPU Intel® Pentium® 4 1.6 GHz or greater is 

recommended)

Operating System : Microsoft® Windows® 2000 operating system (Service Pack 4 or later)*1,
Microsoft® Windows® XP operating system (Service Pack 2 or later)*2,
Microsoft® Windows Server® 2003 operating system (Service Pack 1 or later)*3,
Microsoft® Windows Vista® operating system*4.

System Memory : Recommended Memory for each OS:

Microsoft® Windows® 2000 operating system : 256 MB or more

Microsoft® Windows® XP operating system : 512 MB or more
Microsoft® Windows Server® 2003 operating system

Microsoft® Windows Vista® operating system : 1 GB or more

Interface : 10Base-T/100Base-TX Ethernet Port, USB Port, Parallel Port
(The interface that can be used is different depending on the model)

CD-ROM Drive : Used for installing the software and utilities from the CD-ROM

Free Disk Space : 300 MB or more (For installation and work space, not including storage space)

*1 Microsoft® Windows® 2000 operating system (hereafter Windows 2000)
*2 Microsoft® Windows® XP operating system (hereafter Windows XP)
*3 Microsoft® Windows Server® 2003 operating system (hereafter Windows Server 2003)
*4 Microsoft® Windows Vista® operating system (hereafter Windows Vista)

Application Software: Microsoft® Internet Explorer® 6.0 Service Pack 1 or later

* The following Operating System is not supported :
 Microsoft® Windows Server® 2003 Enterprise Edition for Itanium®-based systems
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C
onfi guring the 

Printer D
river Settings

Confi guring the Printer Driver Settings
Used for confi guring optional devices installed on the printer.
If the printer is connected to the Network (TCP/IP), use Auto Confi guration to confi gure the optional devices 
installed on the printer or obtain information on the printer driver settings.

Note:
To change the Device Options settings, logon to the computer/network using an account with administrator rights.

1 Open the Printer Dialog Box.

 Windows XP/Windows Server 2003 : Select Start → (Settings) → Printers and Faxes
 Windows 2000 : Select Start → Settings → Printers
 Windows Vista : Select Start → Control Panel → Hardware and Sound : Printers

2 The Printers and Faxes (Printers) window appears.
 Right-click the printer icon that you want to confi gure, and select Properties.

3 The Printer Properties dialog box appears.
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  Form/Tray Tab
Assigning media to specifi c trays can prevent printing mistakes and instances when the printer stops because of 
paper mismatches.

Tray Assignment
Specifi es the Paper Size and Media Type assigned 
to the printer's Tray.
Select the paper tray from the list box, and then 
choose the paper size and media type.

Paper Size
Specify the paper sizes loaded in each tray.
If you do not want to assign the paper size, select 
Unspecifi ed.

Media Type
Specify the type of media loaded in each tray.
If you do not want to assign the media type, select 
Unspecifi ed.

Note: 
If the Multi-Purpose Tray was selected, ensure that the • 
media type selection in the control panel matches the 
media loaded on the tray. 

After specifying the paper size and media type loaded in • 
each tray, the settings are not yet initiated on the printer 
and require activation.

To activate the settings, click the • Advanced tab and 
select Hold mismatched documents. This ensures 
printing jobs are held in the case of mismatches between 
the specifi ed tray and the type of paper loaded.

Note:
This is a sample screen.
Availability of the printer features are 
different depending of the models or the 
operating systems.
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      Device Tab
Used for confi guring optional devices installed on the printer.
If the printer is connected to the Network (TCP/IP), use Auto Confi guration to confi gure the optional devices 
installed on the printer or obtain information on the printer driver settings.

Note:
This is a sample screen.
Availability of the printer features are 
different depending of the models or the 
operating systems.

Number of Paper Tray
Specifi es the number of paper trays installed on the 
device.

HDD Unit
Select Installed if a hard disk drive unit is installed.

SD Memory Card
Select Installed if the SD Memory Card (256MB or 
512MB) is installed.

Auto Configuration  button

If the printer is connected to a Network (TCP/IP), 
clicking this button will search for installed printer 
options, which are automatically detected and 
confi gured.

Note:
Make sure that your printer is connected on your network 
properly (TCP/IP only).
The button is not selectable if the Enable printer pooling 
is set to ON and multiple ports are selected on the Ports 
tab.

Restore Defaults  button

Restores all Device tab settings to the factory default 
values.

Edit Support Contacts...  button

Allows the entry and editing of support information.
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   Basic Tab
Basic tab is used for confi guring basic printing settings.

Note:
This is a sample screen.
Availability of the printer features are 
different depending of the models or the 
operating systems.

Paper Size
Displays the current Paper Size and Output Paper 
Size settings.

Paper Image
Represents the current settings, along with the icons 
shown below.

Icons
Represent the current settings, along with the paper 
image shown above.

Printer Status...  button

Used to check the printer status, launch the Device 
Monitor, which displays the status. This feature is 
only available when the printer is connected over a 
TCP/IP network.

Restore All Defaults  button

Restores all the settings to the default value.

 Paper Size/Output Paper Size
There are two settings for paper size. They are 
Paper Size and Output Paper Size.
Paper Size denotes the document size created by 
the software applications.
Output Paper Size denotes the size of paper used 
by the printer.
Custom paper sizes can be selected in the Paper 
Size and Output Paper Size settings. 

Note:
The Media Type and Paper Source settings differ 
depending on the Paper Size/Output Paper Size setting.

Custom Paper...  button
(Available for PCL 6 Emulation Printer Driver only)
You can create, edit and delete custom papers.
Up to 50 custom papers can be registered.

Note:
Custom paper size is saved for individual users who are • 
logged on.

The saved Custom Papers will not be deleted when • 
the PCL 6 Emulation Printer Driver is uninstalled. The 
Custom Paper fi les will be automatically recognized if 
the PCL 6 Emulation Printer Driver of the same model is 
installed again.

For some software applications, you may be able to print • 
the image by changing the paper settings. 

Continue on the next page...
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Orientation
Specifi es the direction of the image to be printed.

Media Type
Specifi es the type of paper.

Paper Source
Specifi es the tray to be used for printing.

Automatically Select Paper is supplied from the tray that is loaded with the specifi ed paper. If the 
specifi ed paper is loaded in multiple trays, it is supplied from the upper tray fi rst. 
If a tray runs out of paper, paper is supplied from the next tray containing the 
specifi ed paper, and continues in this sequence.

Multi-Purpose Tray As its name suggest, this tray is used for all supported sizes and media types that 
can fi t in this tray.

Tray 1 This is the standard paper tray, and the fi rst tray the specifi ed paper is fed from.

Tray 2 This tray is the second paper source tier and optional tray. The optional tray is only 
displayed if it is installed on the machine.

Note:
Be sure to specify on the printer what paper is loaded in the trays.• 

If the settings are wrong, paper will not be supplied correctly when the printer driver is set to • Automatically Select.

Furthermore, be sure to set the paper on the Sheet Bypass properly when • Multi-Purpose Tray is selected.

After installing the optional paper feeder, you must change the • Number of Paper Tray on the Device tab of the printer 
driver. For details, see Device Tab on page 8.

 Cover Page...  button 
(Available for PCL 6 Emulation Printer Driver only)
You can confi gure the settings for cover pages.
To use a cover page, select Front Cover or Back Cover.
Specify the Cover Type either Blank or Printed.

Blank : Produces a blank cover page from the specifi ed paper source.
Printed : Prints the fi rst or last page as the cover page from the specifi ed paper source.

In Other Pages section, specifi es the media type and paper source used for pages other than the Front and 
Back covers. Confi gure the same way as carried out for Media Type and Paper Source in the Basic tab.

Note:
Cover pages are not available with • Reverse Page Order.

Cover pages are not available with • Poster.

Back Cover Page•  is not available with Booklet.
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 Duplex
Duplex (double-sided) is the process of printing on both sides of a piece of paper.

None Select this for single-sided printing. The default is None.

Flip on Long Edge Perform double-sided printing, fl ipping the paper along its long edge 

Flip on Short Edge Perform double-sided printing, fl ipping the paper along its short edge 

Flip on Long Edge 
with Margin Perform double-sided printing, fl ipping the paper along its long edge with margin.

Flip on Short Edge 
with Margin Perform double-sided printing, fl ipping the paper along its short edge with margin.

Note:
Duplex printing is available if Media Type is set to Plain Paper.

Duplex Margin (Available for PCL 6 Emulation Printer Driver only)
Specifi es the gutter for duplex printing. 
Set the gutter in a range of 0 mm - 50 mm (0.0" - 2.0").

Layout Print
Allows printing of documents in a variety of layouts.

 
Pages per Sheet Save paper by printing several pages reduced onto a single sheet.

 
Booklet 

This feature is handy for creating your own booklets. After printing, fold 
sheets in half to create booklets.

Fit to Output Paper 
Size

Scales the source document to fi t it onto the specifi ed paper.

Zoom Prints documents at the specifi ed magnifi cation.

Poster
Enlarges single-page documents for printing on several sheets. Assemble 
the printed documents to make posters.
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Pages per Sheet ■

Several pages are reduced in size and printed next to each other on single sheets. This feature is convenient for 
printing test sheets and conserving paper.

Paper Size
Displays the current Paper Size and Output Paper 
Size settings.

Paper Image
Represents the current settings, along with the icons 
shown below.

Icons
Represent the current settings, along with the paper 
image shown above.

Pages per Sheet
Specifi es how many pages to reduce and print on 
single sheets.
Choose from 2 up, 4 up, 6 up, 8 up, 9 up, or 16 up.

Page Order
Specifi es the order in which multiple pages are 
arranged on single sheets.

Page Border
Select this option to print a border around each 
page.

Solid Print a solid line around each page.

None Do not print page borders.

Style for Mixed Orientation
In print jobs with different paper orientations, this 
option specifi es in which direction the printed image 
is rotated.

Rotate Left 90 Rotates the printed image 
counter-clockwise 90°

Rotate Right 90 Rotates the printed image 
clockwise 90°

Not Rotate Do not rotate the image.

Output Paper Size
Specify the size of paper used by the printer.
The settings are the same as for Output Paper Size 
confi gured in the Basic tab.
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Paper Size
Displays the current Paper Size and Output Paper 
Size settings.

Paper Image
Represents the current settings, along with the icons 
shown below.

Icons
Represent the current settings, along with the paper 
image shown above.

Binding
Specifi es the side that is closed after folding printouts 
in half.

Left Binding

Right Binding

Unit
Specifi es the unit (sheet quantity) to be folded in 
half.
Choose from All Sheets, 1 Sheet, 2 Sheets, 4 
Sheets, or 8 Sheets.

Gutter
Specifi es the space added between the center and 
the printing area when the printout is folded in half.
Set the gutter in a range of 0 mm - 50 mm (0.0" - 
2.0").
Be aware that the margin added by the software 
application will be appended to the gutter, so the 
actual gutter will be wider than the gutter you specify. 

Style for Mixed Orientation
In print jobs with different paper orientations, this 
option specifi es which direction the printed image is 
rotated.

Rotate Left 90 Rotates the printed image 
counter-clockwise 90°

Rotate Right 90 Rotates the printed image 
clockwise 90°

Not Rotate Do not rotate the image.

Output Paper Size
Specify the size of paper used by the printer.
The settings are the same as for Output Paper Size 
confi gured in the Basic tab.

Booklet ■

Fold printouts in half to make booklets. This feature is handy for creating your own booklets. If you create 
booklets from a large number of pages, you can increase the Unit number to divide them into several booklets.
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Fit to Output Paper Size ■

Scales the source document to fi t the specifi ed 
paper. For example, this feature is convenient for 
printing A3/Ledger source documents on A4/Letter 
paper.

Paper Size
Displays the current Paper Size and Output Paper 
Size settings.

Paper Image
Represents the current settings, along with the icons 
shown below.

Icons
Represent the current settings, along with the paper 
image shown above.

Maintain aspect ratio

Selecting this option preserves the 
aspect ratio (the ratio of height to 
width) when documents are scaled.

When the check mark is removed, 
documents will be scaled to fi ll up the 
maximum print area on the page.

If you want to ensure the document is not distorted, 
select Maintain aspect ratio.

Output Paper Size
Specify the size of paper used by the printer.
The settings are the same as for Output Paper Size 
confi gured in the Basic tab.

Zoom ■

You can reduce or enlarge documents by specifying 
the desired magnifi cation. You can also specify 
where scaled documents are positioned on the page.

Paper Size
Displays the current Paper Size and Output Paper 
Size settings.

Paper Image
Represents the current settings, along with the icons 
shown below.

Icons
Represent the current settings, along with the paper 
image shown above.

Zoom
The magnifi cation range can be adjusted between 
25-400%.

Note:
Depending on the Paper Size setting, 400% enlargement 
may not be available.

Image Position
Specifi es the image position after scaling.

Output Paper Size
Specify the size of paper used by the printer.
The settings are the same as for Output Paper Size 
confi gured in the Basic tab.
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Poster ■

Enlarges a single-page source document for printing in a specifi ed number of sheets. You can use this feature to 
print large posters, just assemble the printed sheets.

Paper Size
Displays the current Paper Size and Output Paper Size settings.

Paper Image
Represents the current settings, along with the icons shown below.

Icons
Represent the current settings, along with the paper image shown above.

Style
Specifi es the number of sheets to print the image on.

Note:
Depending on the Paper Size setting, the selectable styles are shown as image icon.

Overlap
Specifi es the amount of overlap involved when printed sheets are assembled. 
(0 mm - 50 mm (0.0" - 2.0")).

Output Paper Size
Specify the size of paper used by the printer.
The settings are the same as for Output Paper Size confi gured in the Basic tab.
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   Output Tab
Output tab is used for confi guring output settings.

Paper Size
Displays the current Paper Size and Output Paper 
Size settings.

Paper Image
Represents the current settings, along with the icons 
shown below.

Icons
Represent the current settings, along with the paper 
image shown above.

Printer Status...  button

Used to check the printer status, launch the Device 
Monitor, which displays the status. This feature is 
only available when the printer is connected over a 
TCP/IP network.

Copies
Specifi es the number of copies to be printed.

Collate

Copies are stacked in the order 
they are printed. Multiple copies 
are printed in separate sets in the 
specifi ed quantity. For example, if 
you print three copies of a fi ve-page 
document, the printer prints pages 
1-5 three times.

Remove the check mark to print 
individual pages in the specifi ed 
quantity. For example, if you 
print three copies of a fi ve-page 
document, the printer prints page 1 
three times before printing page 2 
and so on.

Note:
Collated printing may take some time if the Printer Driver 
is selected in Copy Controlled by. See 
“ Output Options...  button” on page 17. Document 
data is processed repeatedly, as many times as the 
number of copies specifi ed.

Note:
This is a sample screen.
Availability of the printer features are 
different depending of the models or the 
operating systems.
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Reverse Page Order
Select this option to print in reverse (fi rst page prints 
last) order.

Note:
Reverse Page Order cannot be used when Duplex, • 
Pages per Sheet, Booklet or Poster is selected.

 Output Options...  button

Copy Controlled by:
Specifi es how collated printing is carried out when 
Collate is on.

Printer:• 
Collated printing is controlled by the printer.
Printer Driver:• 
Collated printing is controlled by the printer driver. 
If the printer does not have enough memory for 
collated printing, try changing this setting.

Note:
Printing may take a while when • Printer Driver is selected 
because collation is processed internally by the printer 
driver.

The • Printer Driver is not selectable if the Front Cover or 
Back Cover is specifi ed on the Basic tab. (See page 10)

Check Printer Status Prior to Printing:
Selecting this option obtains the printer status before 
printing to ensure printing is possible.
If printing is not possible, a warning dialog box is 
displayed.

Print Blank Pages:
Selecting this option will enable printing blank pages.

Note:
The • Print Blank Pages is not selectable if the Duplex, 
Pages per Sheet,  Booklet or Poster is set to be 
enabled on the Basic tab. (See pages 11-15)

If the • Watermark or Overlay is set to be enabled on 
the Effects tab, the device prints a blank page even the 
Print Blank Pages is set off.
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    Job Type Tab
Job Type tab is used for confi guring and identifying print jobs.

Paper Size
Displays the current Paper Size and Output Paper 
Size settings.

Paper Image
Represents the current settings, along with the icons 
shown below. 

Icons
Represent the current settings, along with the paper 
image shown above.

Printer Status...  button

Used to check the printer status, launch the Device 
Monitor, which displays the status. This feature is 
only available when the printer is connected over a 
TCP/IP network.

Job Type
Printed documents can be saved on the printer's 
hard disk drive (HDD), or SD Memory Card if the 
printer is equipped with one. Saved documents can 
be printed via the printer control panel. See Mailbox 
on page 40.

Note:
Using • Job Type requires that the optional Hard Disk 
Drive Unit or SD Memory Card  is installed in the 
printer, and the HDD Unit, or SD Memory Card must be 
Installed in Device tab. See Device Tab on page 8.

Enter the User ID (up to 8-digit).• 

Enter the Password (4-digit).• 

Note:
This is a sample screen.
Availability of the printer features are 
different depending of the models or the 
operating systems.

Mailbox

Saves print data in the printer, 
in the mailbox specifi ed by the 
User ID. The User ID must 
be entered to print documents 
saved in Mailbox. 

 
Secure Mailbox

Saves print data in the printer, 
in the mailbox specifi ed by 
the User ID. The User ID and 
Password must be entered to 
print confi dential documents 
saved in Secure Mailbox. 



19

C
on
fi g

ur
in

g 
th

e 
Pr

in
te

r D
riv

er
 S

et
tin

gs

Input when Printing
Selecting this option under each item in the Job Type tab (Job Type/Department Counter), User ID (and 
Password) can be entered when a print job is sent to the device.  

Department Counter
If the printer has been set up with Department Codes, the Dept. ID must be provided before printing. (Printing 
is not permitted without an ID.)
Enter the Dept. ID assigned by the administrator.
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   Quality Tab
Quality tab confi gures the settings that determine the print quality.

Paper Size
Displays the current Paper Size and Output Paper 
Size settings.

Paper Image
Represents the current settings, along with the icons 
shown below.

Icons
Represent the current settings, along with the paper 
image shown above.

Printer Status...  button

Used to check the printer status, launch the Device 
Monitor, which displays the status. This feature is 
only available when the printer is connected over a 
TCP/IP network.

Resolution
Specifi es the printing resolution.
Choosing a higher resolution improves the print 
quality but slows printing.

1200 dpi Prints at a print engine resolution of 
1200x1200 dpi.

600 dpi Prints at a print engine resolution of 
600x600 dpi.

300 dpi Prints at a print engine resolution of 
300x300 dpi.

Graphics Mode

Vector Treat line information of lines as Graphic 
data.

Raster Treat all information as Bitmap data.

Halftone
PCL 6 Emulation Printer Driver• 
Normal, Fine, and Coarse can be selected.
Standard Printer Driver • 
None, Dither, and OS Halftone can be selected.

Note:
This is a sample screen.
Availability of the printer features are 
different depending of the models or the 
operating systems.
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Density/Contrast (Available for Standard Printer 
Driver only)
Defi nes the darkness of the dots printed on the 
paper.

Note:
This option available when Halftone is None.• 

Toner Save
Choose this option to conserve toner. The overall 
effect is lighter, so this feature is recommended 
for test printing or producing documents for which 
appearance is not critical.

Print All Text as Black
Prints all colored text in black. In grayscale mode, 
colored text may appear faint when printed. When 
this option is on, the printer prints all text in black for 
better legibility.

Note:
This does not change the color of text created as • 
graphics.

When the Text color is in white, it does not change its • 
color to black if you are using the Standard Printer Driver.
However, if you are using the PCL 6 Emulation Printer 
Driver, the text color will change to black if  Print All Text 
as Black is enabled. Please disable the checkbox if the 
background of a printing document is in black.

Print Fine Patterns
(Available for PCL 6 Emulation Printer Driver 
only)
Change this option if you are getting unexpected 
result with print fi les and patterns.
If this option is set “ON”, it may cause difference 
between on-screen appearance and printed out.

Font...  button

(Available for PCL 6 Emulation Printer Driver 

only)

Allows you to confi gure the font settings.

TrueType Fonts:
Specifi es how TrueType® fonts are downloaded by 
the printer.

Download as 
Bitmap Font

Download fonts as Bitmaps.

Download as 
Outline Font

Download fonts as Outlines. 
If the document includes a 
lot of text in large fonts, this 
may reduce the amount of 
print data.

Note:
Depending on the type of characters, in some cases, • 
even if Download as Outline Font is selected, fonts may 
be downloaded as bitmaps.

Use Device Fonts:
Selecting this option makes the printer use resident 
fonts matching the document fonts. In this case, 
printing is faster because only the character code is 
transferred, without downloading fonts.

Note:
Even if the fonts installed in Windows and on the printer • 
have the same typeface name, they may be slightly 
different. Thus, do not select this option if you want 
printouts to match the appearance on screen exactly.

Font Substitution Table: 
Substitute a True Type® Font installed on the PC to a 
Device Font.
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   Effects Tab
Add Watermark and/or Overlay to put your own signature on documents. To use these features, click the 
appropriate check box and confi gure the settings.

Paper Size
Displays the current Paper Size and Output Paper 
Size settings.

Paper Image
Represents the current settings, along with the icons 
shown below.

Icons
Represent the current settings, along with the paper 
image shown above.

Printer Status...  button

Used to check the printer status, launch the Device 
Monitor, which displays the status. This feature is 
only available when the printer is connected over a 
TCP/IP network.

Watermark
Check the check box to activate the Watermark 
settings, click the Detail...  button to open the 
setting window. 
(See Page 23)

Overlay
Check the check box to activate the Overlay settings, 
click the Detail...  button to open the setting 
window.
(See Page 25)

Note:
If Watermark and Overlay above are not set, the buttons 
for these features will be deactivated.
To activate these features, check the check box of each 
feature to move to the settings screen.

Note:
This is a sample screen.
Availability of the printer features are 
different depending of the models or the 
operating systems.
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Watermark ■

Your choice of text can be printed in the document foreground or background as a watermark. You can also 
specify the pages for watermark printing.

Preview
For previewing the watermark selected in the list.

Move to center
Specifi es to center the watermark on the page.

Page
Specifi es which pages to print.

All Pages Print the watermark on all 
pages.

1st Page Only Print the watermark only on 
the fi rst page.

All but 1st Page Print the watermark on every 
page except the fi rst.

Odd Pages Print the watermark only on 
odd pages.

Even Pages Print the watermark only on 
even pages.

Layer
Specifi es the order to print layers (the watermark 
and the document).

Watermark in 
Background

Print it in the background of 
the document.

Watermark in 
Foreground

Print it in the foreground of the 
document.

Watermark List
Lists the watermarks that have been created. A 
preview of the selected watermark is displayed in the 
preview area.

Delete  button

Deletes the watermark selected in the watermark list.

Name
Enter the name to identify the watermark.
Enter 31 single-byte characters or less.

Continue on the next page...

Note:
This is a sample screen.
Availability of the printer features are 
different depending of the models or the 
operating systems.
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Save  button

Watermark names you enter in Name are saved in 
the current setting.
The saved watermark is displayed in the watermark 
list.

String
Enter the text to be printed.
Enter 63 single-byte characters or less.

Font

Select the font by clicking the Select...  button to 
display the font selection dialog box.

Size
Specify the watermark size in a range of 8-500 
Points.

Angle
Specify the angle of watermark text in a range of 
0-360 deg.

Color

Select the color by clicking the Select...  button to 
display the color selection dialog box.

Transparent Text
Select this option for clear watermark text that 
reveals the document underneath.

As Outline Only
Select this option to print the text as an outline.

Border
You can apply a border around the text.

None No border.

Circle Print the text in a circle.

Square Print the text in a square.

Note:
Watermark data is saved for individual users who are • 
logged on. Those created by other users are not listed.

The feature is not enabled if the • Poster is selected on 
the Basic tab. (See page 15)

The saved watermark lists will not be deleted when • 
the PCL 6 Emulation Printer Driver, or the Standard 
Printer Driver is uninstalled. The watermark lists will 
automatically be recognized if the PCL 6 Emulation 
Printer Driver, or the Standard Printer Driver of the same 
model is installed again.

The following characters are not available for the • 
Watermark fi le name.
\ / * ? : ; . " < > |  

(For Standard Printer Driver)• 
When using the Watermark function select Dither for the 
Halftone in the Quality Tab.

(For PCL6 Emulation Printer Driver)• 
When using the Watermark function, select Vector for 
the Graphics Mode in the Quality Tab.
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Overlay ■

Your registered images can be printed in the document foreground or background. It's easy to enhance 
documents with your company name or logo.

Continue on the next page...

Note:
These are sample screens.
Availability of the printer features are different depending of the models or the operating systems.

Preview
For previewing the overlay fi le selected in the list.
The preview does not display until the overlay is 
created.

Print with Overlay File
Print with an overlay. Select an overlay fi le and 
confi gure the Print Options settings.

Make Overlay File
Make the new overlay fi le. The fi rst page will be 
saved (without printing) as overlay data.

Note:
Only the fi rst page of multi-page documents can be used 
as overlay data.

Overlay Files
List the overlay fi les that have been created.
A preview of the selected overlay fi le is displayed on 
the left of the dialog box.

Delete  button

Delete the selected overlay fi le.

Page
Specifi es which pages to print.

All Pages Print the overlay on all pages.

1st Page Only Print the overlay only on the 
fi rst page.

All but 1st Page Print the overlay on every page 
except the fi rst.

Odd Pages Print the overlay only on odd 
pages.

Even Pages Print the overlay only on even 
pages.
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Layer
Specifi es the order to print layers (the overlay fi le 
and the document).

Overlay in 
Background

Prints the overlay in the 
background, under the 
document.

Overlay in 
Foreground

Prints the overlay in the 
foreground, over the 
document.

Overlay File Name
Enter the name of overlay fi le up to 63 single-byte 
characters.

Note:
The following characters are not available for the Overlay • 
File Name.
\ / * ? : ; . " < > |  

Overlay fi le is saved for individual users who are logged • 
on.

The feature is not enabled if the • Poster is selected on 
the Basic tab. (See page 15)

The saved overlay fi les will not be deleted when the • 
PCL 6 Emulation Printer Driver, or the Standard Printer 
Driver is uninstalled. The overlay fi les will automatically 
be recognized if the PCL 6 Emulation Printer Driver, or 
the Standard Printer Driver of the same model is installed 
again.
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   Profi le Tab
Registering the current settings as a profi le makes it easy to recall the settings next time you print. The 
frequently used settings you save as profi les are easily adjustable as required.

Paper Size
Displays the current Paper Size and Output Paper 
Size settings.

Paper Image
Represents the current settings, along with the icons 
shown below.

Icons
Represent the current settings, along with the paper 
image shown above.

Printer Status...  button

Used to check the printer status, launch the Device 
Monitor, which displays the status. This feature is 
only available when the printer is connected over a 
TCP/IP network.

Profi les
List the profi les that have been created.
DEFAULT is the factory setting. UNTITLED is the 
current setting that has not been saved.

Save as...  button

Save the current settings. The profi le is named 
and comments can be added before saving. If the 
name of an existing profi le is used, that profi le is 
overwritten.
Enter 31 single-byte characters or less for the profi le 
name, 127 or less for the comment.
If you select Do not save Paper Size and 
Orientation, Paper Size and Orientation will not 
be saved in the profi le. These Paper settings are 
also confi gured in each software applications, so it is 
advisable to check Do not save Paper Size and
Orientation before saving the profi les.

Note:
DEFAULT•  and UNTITLED cannot be used as profi le 
names.

The saved profi les will not be deleted when the PCL 6 • 
Emulation Printer Driver, or the Standard Printer Driver 
is uninstalled. The saved user profi les will automatically 
be recognized if the PCL 6 Emulation Printer Driver, or 
the Standard Printer Driver of the same model is installed 
again.

Continue on the next page...

Note:
This is a sample screen.
Availability of the printer features are 
different depending of the models or the 
operating systems.
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Delete  button

Deletes the selected profi le.
Settings details of the deleted profi le will be retained 
in the UNTITLED profi le until the settings are 
changed.

Note:
The profi les DEFAULT and UNTITLED cannot be deleted.

Export...  button

Saves the selected profi le as a fi le.

Note:
The profi les DEFAULT and UNTITLED cannot be 
exported.

Import...  button

Loads an exported profi le and adds it to the list of 
profi les.

Different settings from DEFAULT
Displays the differences between the current setting 
and the default setting.

Comment
Displays comments about the profi le.
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   Support Tab
Displays the printer driver version and various support information.

Version Information
Displays the version of printer driver confi guration 
fi les.

Driver Download...  button

Launches the default web browser and accesses the 
manufacturer’s download site to download the latest 
Printer Driver.

Support Contacts...  button

Displays the dialog box with support information 
registered in the driver.

Note:
This is a sample screen.
Availability of the printer features are 
different depending of the models or the 
operating systems.
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Confi guring the Printer Driver Settings (For DX-800)
Device Settings Tab ■

Harftone Setup... Properties...  button

Select the method of expressing device halftone 
(printer-specifi c halftone). Select the settings 
according to printing data and preference.

Halftone Pattern• 
Select the pixel size to be used for halftones.
The greater the value, the coarser the image 
would become. However, a larger value is suited to 
printing in large areas.
The Enhanced pattern allows printing at a higher 
resolution using the same number of pixels. 
However, the pattern might generate unnatural 
lines, patterns, moire effects, and so on depending 
on the image to be printed.

Device Gamma• 
Adjust the gamma of print images (color 
intensities).

Pixel Diameter• 
Adjust the darkness of the print image. Manipulate 
the slider to specify the pixel size. You can select
between specifying the real size in inches or 
specifying in percentage relative to the printer 
resolution.

Luminance (CIE Y)• 
Adjust the luminosity of the print image.

Number of Paper Tray
Select the number of available paper trays for the 
printer if an optional Paper Feed Module is installed.

Note:
Device Settings•  Tab specifi es device-specifi c settings 
and settings of optional devices. Refer to operation 
manuals of the optional devices, or on-line manuals for 
settings items.

Settings specifi ed in this section are saved as standard • 
(default) settings of the printer.
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Orientation
Select the print orientation (Portrait/Landscape).

Advanced...  button
Specify detailed settings.

Paper Source
Specify where the paper you want to use is located 
in the machine. If you choose Auto Selection, the 
printer driver will automatically select an appropriate 
tray according to the Paper Size.

Advanced...  button
Specify detailed settings.

Layout Tab ■ Paper/Quality Tab ■
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Advanced ■

Paper Size
Select a document size.

Resolution
Select the printer resolution (300dpi/600dpi).

Scaling
Specify custom zoom when printing a document by 
zooming in/out at a desired rate. If the zooming rate 
is specifi able in an application, specify "100%" (same 
size) here. Specify a zooming rate in the print dialog
box of the application.

Metafi le Spooling
With Metafi le Spooling enabled, the fi le is spooled in 
EMF format (metafi le compression). With the
function disabled, the fi le is spooled in RAW (non-
compression) format. Specifying RAW format 
results in longer time before placing an application 
operational after printing on the application.

Note: 
Spooling by EMF format may cause the following problems 
on some application software.
1) Printing result is different from the screen display.
2) Printing requires excessive time.

N in 1
For printing two or more pages on one sheet, specify 
a printing method.
Layout is selected by combining with "Orientation." 
2 in 1 : Print 2 pages of documents zoomed out on 

one sheet.
4 in 1 : Print 4 pages of documents zoomed out on 

one sheet.

Halftone Color Adjustment

Contrast• 
Adjust the contrast of print images.
Brightness• 
Adjust the brightness of print images.
Dark Picture• 
Select this option in order to print dark images 
brighter.
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Negative• 
Select this option in order to print images with 
black and white reversed.
Input RGB Gamma• 
Adjust the gamma of print images (color 
intensities). Red, Green and Blue can also be 
adjusted individually.
Black Ref/White Ref• 
Adjust the difference between the darkest and 
lightest colors of an image. Increasing the Black 
Ref value or decreasing the White Ref value will 
intensify the contrast of the image but reduces the 
range of colors in between.
Picture• 
Select a test pattern type.
Selecting the View check box will display halftone 
adjustment results in the test pattern.
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Confi guring the Printer Driver Settings 
(For UF-4000/4100/6000/6100, UF-6200/6300)

Device Options Tab ■

Used for confi guring optional devices installed on the printer.

Number of Paper Trays
Specifi es the number of paper trays installed on the device.

Restore Defaults  button

Restores all Device tab settings to the factory default values.

Note:
This is a sample screen.
Availability of the printer features are different 
depending of the models or the operating 
systems.
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Paper Tab ■

Paper tab is used for confi guring basic printing settings.

Paper Size / Output Size
Paper Size denotes the document size created by 
the software applications. Output Size denotes the 
size of paper used by the printer.

Copies
Specifi es the number of copies to be printed.

Orientation
Specifi es the direction of the image to be printed.

Zoom
Specify an enlargement or reduction percentage 
when printing documents.  If enlargement/reduction 
can be set within the application, indicate 100% here 
and specify the enlargement/reduction percentage in 
the Print dialog box of the application.

Paper Source
Specify where the paper you want to use is located in 
the device. If you choose Auto Tray Selection, the 
printer driver will automatically select an appropriate 
tray according to the Paper Size selected.

Note:
Be sure to specify on the printer what paper is loaded 
in the trays. If the settings are wrong, paper will not be 
supplied correctly when the printer driver is set to Auto 
Tray Selection.

About...  button

Displays the dialog box with the driver fi le version.

Restore Defaults  button

Restores each tab settings to the factory default 
values.

Note:
This is a sample screen.
Availability of the printer features are different 
depending of the models or the operating 
systems.
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N in 1
Specify the layout pattern for printing multiple 
documents on a single sheet of paper. If you select 
an item other than None, N in 1 order is displayed, 
allowing you to select the following patterns.

Sort
Select whether to Non Sort or Sort when printing 
the multiple copies.

Note:
If the collation can be specifi ed within the application, clear 
the collation setting of the application to make this setting 
effective.

Output Order
Specify the output order (Ascending/Descending).

Advanced...  button

Displays the Advanced dialog box with the following 
settings:

 Print All Text as Black
 All colored text is printed as solid black.

Note:
The function of Print All Text as Black become active if 
Halftone on Quality Tab is set in “None” or “Dither”.

Restore Defaults  button

Restores each tab settings to the factory default 
values.

Note:
This is a sample screen.
Availability of the printer features are different 
depending of the models or the operating 
systems.

Output Tab ■

Output tab is used for confi guring output settings.
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Halftone
Adjust the Halftone Color of print images.

Resolution
Specifi es the printing resolution. Choosing a higher 
resolution improves the print quality but slows 
printing.

Note:
dpi (dots per inch) represents the number of dots 
contained in one inch. The larger the value, the higher the 
resolution would be.

Contrast
Defi nes the darkness of the dots placed on the 
paper.

Note:
The function of Contrast become active if Halftone is set 
in “None”.

About...  button

Displays the dialog box with the driver fi le version.

Restore Defaults  button

Restores each tab settings to the factory default 
values.

Note:
This is a sample screen.
Availability of the printer features are different 
depending of the models or the operating 
systems.

Quality Tab ■

Quality tab confi gures the settings that determine the print quality.
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Printing from Windows Applications (Local/Network) ■

If the printer driver installed properly and is selected as the default printer in the printer setup, printing from any 
Windows application is a simple operation.

When sharing a printer by connecting two or more computers via network, a connection between the computers 
can be verifi ed by displaying the connected computers in the Network Neighborhood on the desktop.
The network printer correctly connected can be treated just like the local printer (The cable mark has adhered to 
the icon of the network printer).

Note:
Refer to the explanation on how to specify printer sharing settings in another provided document, the Operating Instructions 
(For Setting Up).

To print from most Windows applications, use the Print command in the File menu. Selecting the Print command 
typically displays the Print dialog box.

  

Setup your preferred confi guration (page range, number of copies, etc.) fi rst, and then click the Print  
button to start printing.
While documents are being printed, a printer icon appears in the System Tray near the clock in the bottom right 
hand corner of the screen. The icon disappears when printing is completed.
You may double-click the printer icon in the system tray to open and verify the details of the print queue.

Note:
If more than one printer is installed on your PC, follow the steps below to set a default printer:

1. Open the Printer Dialog Box.
 Windows XP/Windows Server 2003 : Select Start → (Settings) → Printers and Faxes
 Windows 2000 : Select Start → Settings → Printers
 Windows Vista : Select Start → Control Panel → Hardware and Sound : Printers

2. The Printers and Faxes (Printers) window appears.
 Right-click the desired printer icon, and then select Set as Default Printer in popup menu. The check mark next to the 

printer icon denotes a Default Printer.
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IPP (Internet Printing Protocol) Printing ■

Prints documents from a machine located in a remote area via the Internet without its access being blocked by a 
proxy server.

Note:
It is necessary to install • RPT Network Printer Port beforehand to setting up IPP Printing.

IPP(Internet Printing Protocol) Printing is not available for Standard Printer Driver.• 

1 Open the Printer Dialog Box.

 Windows XP/Windows Server 2003 : Select Start → (Settings) → Printers and Faxes
 Windows 2000 : Select Start → Settings → Printers
 Windows Vista : Select Start → Control Panel → Hardware and Sound : Printers

2 The Printers and Faxes (Printers) window appears.
 Right-click the printer icon that you want to confi gure, and select Properties.

3 The Printer Properties dialog box appears.

 Select Ports tab, and click the Add Port...  button.

4 The Printer Ports dialog box appears.

 Select RPT Network Printer Port and click the New Port...  button.

5 The RPT Network Printer Port Wizard appears.

 Select Print using IPP, and click the Next >  button.

6 Select Connect using a local area network, and click the Next >  button.

7 Select Do not print using a proxy server, and click the Next >  button.

8 Input the Printer's IP address after the "http://", and add "/printer" at the end.
 (Ex : http://133.185.254.106/printer )
 Click the Next >  button to proceed.

9 Verify that the Destination print port name is OK (change if necessary), and click the Next >  button.

10 Click the Finish  button.

11 Close the Printer Ports dialog box, and check the new port has been added.
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Mailbox and Secure Mailbox Printing ■

The document printed adding User ID (and Password) with the printer driver is stored in the Mailbox (or 
Secure Mailbox) of the printer.
To retrieve (print) the document, you must enter the User ID (and Password) at the printer's operation panel.

Saving a document data (from a PC)

1 Select Print in the File menu of the application. (Ex: Microsoft® WordPad)

2 Click the Preference  button in the Print dialog box.

3 Click the Job Type tab in the Printing Preferences dialog box.

4 Check the “Mailbox” or the “Secure Mailbox”, and enter the User ID (up to 8 digits) and the Password (4 
digits).

5 Click the O K  button to close the Printing Preferences dialog box.

 And then click the O K  button in the Print dialog box. The document data is stored into the Mailbox 
or the Secure Mailbox of the printer.

Retrieve a document data (from a printer's operation panel)
Follow the procedure below to print a fi le from a Mailbox or Secure Mailbox on your machine.

Note:
The detailed operating procedure is different depending on the model.
Refer to the Operating Instructions of the printer when it is necessary to select the function number for the Mailbox and 
Secure Mailbox Printing.

1 Press the Print  key to set in to the printer mode.
 Print display appears on the printer control panel.

2 Enter the mailbox User ID number (up to 8 digits) from the keypad.
 The display shows the saved document data in the selected mailbox.

3 Choose the document you want to print, and press the PRINT  .

 When you want to delete the document, press the DELETE  .

4 (Secure Mailbox only)
 Enter the secure mailbox Passward (4 digits) from the keypad.
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Troubleshooting

Printing Operation Failure ■

If the printing operation fails, check the following items fi rst:

Ensure the connecting cable (USB, Parallel, or Ethernet LAN cable) is properly connected.• 
Power of the device is turned ON.• 
Paper is loaded properly in the device.• 
An error message is not displayed on the device. • 

The above points can be verifi ed by printing a test page on the following procedures.

1 Open the Printer Dialog Box.

 Windows XP/Windows Server 2003 : Select Start → (Settings) → Printers and Faxes
 Windows 2000 : Select Start → Settings → Printers
 Windows Vista : Select Start → Control Panel → Hardware and Sound : Printers

2 The Printers and Faxes (Printers) window appears.
 Right-click the printer icon that you want to confi gure, and select Properties.

3 The Printer Properties dialog box appears.

 Select General tab, and then click Print Test Page  button.
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Documents Not Printing Correctly ■

Problem Possible Cause / Solution(s)

Characters are not printed in the correct positions 
or the characters near the edges of the page are 
missing.

- Check and specify the paper size and the orientation 
settings in the printer driver to coincide with the 
application.

- The characters are set outside the printing area of 
the machine.

Incorrect font type. - Check whether the selected font is installed on the 
PC.

- Enable "Use Device Fonts" of the Font dialog box in 
in the Quality Tab.
(For PCL 6 Emulation Printer Driver.)

Printing stops in the middle of the run. - Check whether there is a Network problem.

Although print data is transferred to your machine, 
it does not print.

- Make sure the printer is online.
- Make sure the machine is not in the Shutdown 

Mode. Press ENERGY SAVER key to return to 
standby mode. See the Operating Instructions for 
Copy and Function Parameters for details.

- Make sure the Printer cable is connected properly.
- Restore the power if the On line LED is Off even if 

the USB printer cable is connected.

Incorrect Output Image. - Set Raster for the Graphics Mode in the QualityTab.
 (For PCL 6 Emulation Printer Driver.)
- When the custom paper size is set in the Paper tab, 

confi gure the paper in portrait format.

Printing operation takes excessive time. - The wait time for printing operations depends on 
the spool settings. Set Advanced tab in the Printer 
Properties dialog box.

Paper exits from the unexpected paper tray. - If the paper runs out from the paper tray specifi ed by 
the user, the machine automatically switches to the 
paper tray which contains the same paper size by 
default.

 See the Operating Instructions for Copy and 
Function Parameters for disable the automatic paper 
tray select function.
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Error Messages Displayed on the Computer ■

Problem Possible Cause / Solution(s)

Error writing to USB. Unable to write to the 
Specifi ed device.

- Verify that the device is connected to the computer 
correctly.

- Verify that the power of the device is turned On.

Error writing to USB. Printer timeout error 
occurred.

- Verify that the power of the device is turned On.
- Excessive data volume or number of pages may 

overfl ow the device's memory, disabling data 
reception.

- Increase the timeout setting value in properties (for 
transmission retry).

Printing is disabled due to an error in the current 
printer settings.

- Mismatch in settings such as paper size or printing 
orientation exist between the application and the 
printer driver.

- Correct the settings.
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